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A. EQUIPMENT 

A.1. Vessels 

A.1.1. S1211 
NRT-4 operated a single vessel, S1211 (Fig. 1), a 32-foot, gray, aluminum-hull SeaArk 
Commander.  NOAA Survey Vessel S1211 was powered by dual 200-horse power Honda 
outboards. A Kohler 7.5e generator supplied AC power.  A rack-mount APC Smart-UPS 
(uninterruptable power supply) provided battery backup for the survey-system electronics. 
 

 
Figure 1:  NOAA S1211 (NRT-4) 

A.1.1.1. Calibration & Configuration 
See section C.1.1 for a description of the full vessel survey. 

A.2. Depth Measurement Equipment 
NRT-4acquired bathymetry data with a Kongsberg EM3002 multibeam sonar.  Pseudo-side-scan 
data (not ‘snippets’) were acquired with the EM3002 for general reference, but the data were not 
processed as a deliverable.  No vertical beam echosounder (VBES) data were acquired. 
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A.2.1. Kongsberg Simrad EM3002 Multibeam Echosounder 
The EM3002 is a 300 kHz (nominal) system with a characteristic operating depth range of 1 to 
150meters water depth.  Under ideal, cold water conditions, the range may extend to 200 meters.  
The swath width is 120°, and the nadir beam is 1.5° x 1.5°.  The system has a maximum ping 
rate of 25 Hz.  The processing unit (PU) performs beam forming and bottom detection and 
automatically controls transmit power, gain, and ping rate.  The sonar processor incorporates real 
time surface sound speed measurements for initial beam forming and steering. The Seafloor 
Information System (SIS) application, designed to run under Microsoft Windows, provides 
control and monitoring of the EM3002.  The EM3002 is hull-mounted (see Fig. 2). 
 

 
Figure 2:  EM3002 Hull Blister Mount 

A.2.1.1. Calibration & Configuration 
The overall MBES acquisition system is configured such that SIS logs to the .all files (1) the 
ZDA-synchronized attitude and position of the vessel reference point (the top-center of the IMU) 
and (2) the roll-stabilized raw angles and ranges, which are post-processed in CARIS HIPS (see 
section B.1.2.)  The SIS installation and characteristic runtime parameter reports are included in 
Appendix 6.  See section C.1.3 for a description of the calibration patch test. 
 
A lead line-to-multibeam sonar sounding comparison was conducted on 5/05/14, while stationary 
in calm backwaters adjacent to the Galveston Channel, Galveston, TX.  The measurements 
agreed to the sub-decimeter level with a consistent reading of 2.5 meters.  Figure 3 shows the 
multibeam data in Subset Editor with its reference surface (teal color) turned on. 
 

forward 
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Figure 3:  Lead Line to Sonar Comparison 

 

A.2.1.2. Systematic Artifacts 
The EM3002 MBES data contain an along-track and an across-track systematic artifact, both of 
which are shown in Figure 4. 

 

 

 
Figure 4:  EM3002 Motion Artifacts 

 
Along-track Systematic Error 
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Artifact 

Across-track 

Artifact 

Lead Line 
Measure 
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In areas of soft sediment, the EM3002 data contain an along-track pair of depressions centered at 
nadir. Although the magnitude of the depressions can exceed 0.5m, the nominal magnitude is 0.1 
to 0.15m. Overall, the artifact is not a significant source of error. Although the underlying PVDL 
may be quite noisy, the surface is minimally affected (see Fig. 5). Documented in the Kongsberg 
support manuals, the artifact stems from the acoustic characteristics of the sonar itself, not the 
overall system integration. 

 
Figure 5:  Along-track Artifact (Rear View) 

 
Across-track Systematic Error 
The EM3002 MBES data contain an across-track systematic motion artifact (see Fig. 6).The 
amplitude of the artifact worsens with increased distance from nadir and the magnitude of vessel 
attitude.  In general, the artifact, with a nominal amplitude of 0.1-0.2 m, is not considered a 
significant source of uncertainty; however, sounding data were rejected (via an angle-from-nadir 
filter) in areas where the sum of the node vertical TPU and the amplitude of the artifact exceeded 
the allowable IHO uncertainty.  The hydrographer was unable to definitively identify the source 
of the artifact but suspects that the source is a misalignment between the IMU and vessel 
coordinate frames.     
 

 
Figure 6:  Across-track Artifact (Side Profile View) 

Rejected erroneous Soundings at NADIR 
The EM3002 MBES data contain a string of soundings along nadir that appear within 1ft above 
or below the water surface (see Fig. 7). Most of these soundings are automatically deleted as the 
data is acquired by the Kongsberg (SIS) software but several soundings slip through and need to 
be manually removed. After completing the BIST analysis on the sonar it was determined that 
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the system had 5 bad staves that returned amplitudes considered out of range. Therefore the 
beam forming is comprised and produces some erroneous data. The Built-in Self-Test (BIST) 
results are documented in Appendix 6, page 38 of this document. 
 

 
Figure 7 - Erroneous Soundings at NADIR 

A.2.2. Lead line 
S1211 is equipped with a traditional tiller-rope lead line.  The lead line is graduated with major 
intervals of 1 meter and minor intervals of 20 cm.  The major and minor graduations, relative to 
each other, show excellent agreement with a survey tape. (0.005 meters difference throughout 
entire length of 17 meters.) 
 

A.3. Imaging Equipment 

A.3.1. Edgtech 4125 
The Edgetech 4125 system includes a stainless steel towfish, topside processor unit (TPU) and 
30 meters of Kevlar tow cable.  The towfish’s dimensions are 9.5cm in diameter, 97cm in length 
with an overall weight of 15kg (34 pounds).  It has two frequency ranges; 400-900 kHz and 600-
1600 kHz and is capable of logging data in both frequencies, simultaneously.  Its low frequency 
operating range is 150 meters at 400kHz and 75 meters at 900 kHz.  The high frequency 
operating range is 120 meters at 600 kHz and 35 meters at 1600 kHz. Vertical beam width is 50 
degrees.  The towfish is typically towed at or near 6kts at 4-25 meters water depth. 
The TPU contains a network card for transmission of the sonar data to the acquisition 
workstation.  Sidescan data were logged using the JSF file format.  A Dynapar cable counter data 
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was configured to send data directly into the TPU through the acquisition computer (refer to the 
wiring diagram in Appendix 5). 
 
 

 
Figure 8:  Klein 3000 Side Scan Sonar 

A.3.1.1. Calibration & Configuration 
Sidescan sonar positioning was evaluated as per section 1.5.7of the Field Procedures Manual 
(2013 version).  The resulting 95% confidence radius was 9.9 meters (see Figures 8 - 10), which 
are within the maximum allowed radius of 10 meters.  Wind and moderately strong ebbing 
currents likely confounded positioning accuracy.  The procedure was conducted in 10meters 
water depth, using 75-meter range scale, with, nominally, 10-11 meters of cable out. 
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Figure 9:  SSS Calibration Location (Chart 11324) 

 

EdgeTech 4125 SSS Systems 
Calibration 
NOAA Vessel S1211 
Conducted Using Buoy Block “1”  

h
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Figure 10:  SSS Contacts for Buoy Block, Buoy “1” 

 

 

 

Figure 11:  95% Confidence Radius 

 

A.4. Vessel Position and Orientation Equipment 

A.4.1. TSS POS/MV Position & Orientation Sensor 
S1212 is equipped with an Applanix POS/MV V5 which replaced a POS/MV 320 version 4 from 
prior years.  The POS/MV consists of dual Trimble BD950 GPS receivers (with corresponding 
Zephyr2antennas), an inertial motion unit (IMU), and a POS computer system (PCS).  The two 
antennas are mounted approximately 1.5 meters apart atop the launch cabin (see Fig. 12).  The 
primary receiver (on the port side) is used for position and velocity, and the secondary receiver is 
used to provide heading information as part of the GPS azimuthal measurement sub-system 
(GAMS). 
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Figure 12:  POS/MV Antenna Installation 

The new IMU contains three solid-state linear accelerometers and three solid-state gyros, which 
together provide a full position and orientation solution.  The IMU is mounted on the top of the 
sonar housing (see Fig.13), beneath a deck hatch, forward of the generator compartment.  The 
new IMU’s base plate bolt holes matched the original IMU’s base plate such that each’s 
Reference Point (X and Y origin) matched identically.  However, the new IMU’s Z value 
differed by0.031 meters, downward (see Fig. 13).  Thus, the “Ref. to Primary GPS Lever Arm” Z 
value setting was changed from -2.497 meters to -2.528 in POSView, version 7.2.  This change 
employed the right-hand Cartesian co-ordinate system convention, i.e. +Z=Down, +X=to Bow 
and +Y=to Starboard.  Additionally, this new Z value affected the IMU-to-Waterline offset and 
IMU-to-Transducer offset.  Refer to Section C of this report.  
 

 
Figure 13:  IMU Installation 

 

 

 
Figure 14:  IMU V5 (left) vs IMU V4 (right)

Primary GPS 
Antenna
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A.4.1.1. Calibration& Configuration 
 
The IMU/Base plate was originally installed on June 25, 2009 in Alpena, MI.  One this day, the 
National Geodetic Survey conducted a POS MV Components Spatial Relationship Survey and 
determined the IMU’s reference point to be located 3.851 meters behind, 0.972 meters to 
starboard, and 2.497 meters below the phase center of the primary POS/MV GPS antenna.  
Complete definitions and findings of this survey may be referenced in the appendix of this 
document. 
 
The IMU was reinstalled in June, 2012, after it had been removed for an extended boat-repair 
period.  A spinning-laser level was used to help align the IMU with the vessel coordinate frame.  
The intent was to define the centerline plane by positioning the spinning laser such that the 
projected plane would intersect three reference marks along the physical centerline of the boat 
(see Fig. 15).  The IMU would then be positioned such that the projected plane was aligned with 
the X-axis on top of the IMU.  This laser-based installation method has the benefit of not 
requiring the boat to be locally level with respect to gravity.  After alignment, the IMU was 
bolted down to the top of the MBES and outlined with black paint marker to preserve its location 
relative to the vessel coordinate frame. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 15:  Laser-assisted IMU Installation 

 
A new IMU and baseplate with bolt mounts designed to sustain the RP center was installed on 
January 30, 2014.  A laser level was not employed for the alignment to the Vessel Reference 
Frame as the hydrographer deemed paint markings outlining the old IMU baseplate as adequate 
control (2 millimeters or less in uncertainty to account for a slightly faded paint outline). 
 

Centerline 
Reference Marks Laser 

Level IMU 

Projected Laser Plane Plan View 

Profile View 
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A GAMS calibration was performed on 02/07/2014, in the vicinity of Bolivar Roads, near 
Galveston, TX.  The portside GPS antenna had been replaced because of corrosion and water 
intrusion.  The baseline vector values agree well with previous values (see Table 1).  The GAMS 
report is included in Appendix 9 of this document. 
 
Table 1:  GAMS Calibration Results 

Baseline Vector 2/14/2014  5/09/2013    

X (m) -0.007  0.009    

Y (m) 1.987  1.980    

Z (m) -0.006  -0.001    

 
The POS/MV is configured, operated, and monitored via the POS/MV controller software (see 
software inventory in Appendix 9 for version details), which is installed on the acquisition 
computer (see section A.2.1).The primary GPS-to-reference point lever arm and heave-leaver 
arm were accounted for in the POS/MV controller. A POS/MV configuration report detailing 
lever arms, input/output settings, and operational settings is contained in Appendix 9. 
 
The controller software was also used to initiate Ethernet logging of the POSPac datagram 
bundle, which was used for post-processing of true heave in CARIS and for monitoring of 
various navigation parameters, such as real-time positioning RMS errors, in POSPac Mobile 
Mapping Software (MMS). 
 

A.4.2. Trimble DSM212L DGPS Receiver 
The POS/MV receives differential (RTCM) correctors from a Trimble DSM212L GPS receiver 
that includes a dual-channel low-noise MSK beacon receiver, capable of receiving U.S. Coast 
Guard (USCG) differential correctors.  The DSM212L can also accept RTCM messages from an 
external source such as a user-established DGPS reference station, but typically USCG beacon 
correctors are used.   

A.4.2.1. Calibration & Configuration 
Trimble’s TSIP Talker was used to configure the GPS antenna supplying Coast Guard 
differential correctors to the POS/MV.  Due to COM port limitations, TSIP Talker was installed 
on a separate laptop, not the main acquisition computer. 

A.4.3. Trimble GeoXH GPS Receiver 
A Trimble GeoExplorer 2008 series GeoXH is used to position fixed, non-bathymetry features, 
such as piers, dolphins, and vertical control benchmarks.  NRT4 typically uses the GeoXH with a 
Trimble Zephyr antenna mounted on a 2-meter, bipod-equipped range pole.  The Trimble 
GeoXH combines an L1/L2 GPS receiver with a field computer powered by Microsoft Windows 
Mobile.  TerraSync software is used to acquire data, and Pathfinder software is used to post-
process data and applies differential corrections.  See the software inventory in Appendix 2 for 
version information. 

A.4.4. Trimble SPS361 Modular GPS Heading Receiver  
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A new Trimble SPS361 GPS System was integrated June 24th 2014 to replace NRT4’s older 
DSM212 Trimble Receiver.  The unit may be powered via 12-40 VDC or via Power Over 
Internet (POE).  It is a dual-frequency GPS Heading receiver capable of DGPS positioning using 
the following sources: 
 -Satellite-Based Augmentation Systems (SBAS) 
 -DGPS RTCM corrections from internal MSK Beacon receiver OR external sources 
 -RTK corrections from external sources (limited to DGPS precision) 
 -OmniSTAR VBS correction from internal demodulator or external sources 
Compatible antennas for the SPS361 include GA530, GA510, Zephyr Model 2, and Rugged 
Zephyr Model 2. 
 

A.5. Sound Speed Equipment 
S1211 is equipped with two Odom Digibar Pro surface-sound-speed sensors (one is a spare) to 
measure sound speed at the flat-face multibeam transducer head.  For water column sound speed 
profiles NRT-4 uses a Seabird SBE19+ CTD profiler.  Refer to the hardware inventory in 
Appendix for details regarding serial numbers and recent calibration dates. 

A.5.1. Odom Digibar Pro – Surface Sound Speed 
An Odom Digibar provides surface sound speed data to the flat-face EM3002 for beam steering 
and beam forming.  The unit is lowered into a tube that is mounted on the transom, between the 
two motors (see Fig. 16).  The unit was configured to output an AML datagram to SIS, which 
was installed on the acquisition computer (see wiring diagram in Appendix 5).  The Digibar can 
also be configured, if necessary, to obtain a sound speed profile of the water column. 
 

 
Figure 16:  Surface Sound Speed Digibar Installation 

A.5.2. AML Oceanographic Micro X – Surface Sound Speed 
The Micro X (see Fig. 17) is a sound velocity sensor with interchangeable heads that can 
measure pressure, temperature, turbidity, and, conductivity. The interchangeable heads remove 
the need for downtime during annual calibration since a newly calibrated head can be requested 
in advance. The Micro X provides surface sound speed data to the flat-face EM3002 for beam 
steering and beam forming.  It replaced the Odom Digibar Pro, used in 2013, for the 2014 
season. The unit is lowered into a tube that is mounted on the transom, between the two motors 
(see Fig. 15).  This new tube has been modified to account for the thinner and smaller size of the 
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AML. The unit was configured to output an AML datagram to SIS, which was installed on the 
acquisition computer (see wiring diagram in Appendix 5).  The Micro X can also be configured, 
if necessary, to obtain a sound speed profile of the water column. The Micro X was configured in 
the SeaCat software program that came with the sensor. It is set to output at a baud rate of 9600 
and the output was also modified so that only one decimal place is reported rather than the 
factory setting of 3. 
 

 
Figure 17 - AML Oceanographic's Micro X 

A.5.3. Seabird SBE19+ CTD Profiler 
A Seabird SBE19+ CTD was used to obtain sound speed profiles of the water column.  The raw 
file, containing conductivity, temperature, and pressure data, was first uploaded to the acquisition 
computer and then processed using Velocwin, which generated .svp files to be used in CARIS 
post-processing. 

A.5.3.1. Calibration & Configuration 
A sound-speed-cast comparison for both sensors was performed on 2/14/14 in Galveston Bay, 
TX. The cast profiles from the CTD and digibar exhibited superb agreement (within 1.1 meters 
per second).  See Sound Speed Equipment Report included in Appendix 1 for annual, factory 
calibration reports. 
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Figure 18:  Sound-Speed Profile Comparison 

A.6. Tides & Leveling Equipment 
NRT-4 has a Sokkisha B1 automatic optical level and a Mount City fiberglass survey rod, but 
this equipment was not used during 2014. 

A.7. Software 
A complete list of software and versions is included in Appendix 2. 
 
 
B. QUALITY CONTROL 

B.1. Multibeam Echosounder Data 

B.1.1. Acquisition Operations 

B.1.1.1. Coverage Schemes 
Multibeam coverage schemes include mainscheme and development acquisition.   
 
Mainscheme 
Mainscheme multibeam data, the intent of which is to obtain bathymetry over an entire area, are 
acquired using one of two methods – “skunk-stripe” or “paint-the-bottom.” 
 
Skunk-Stripe – The skunk-stripe scheme refers to the pattern of MBES coverage resulting from 
running MBES concurrently with sidescan sonar (SSS) operations.  Because SSS operations are 
conducted with a set line-spacing optimized for sidescan coverage, the corresponding MBES 
coverage is often a series of parallel, non-overlapping swaths.  Skunk-stripe MBES data are 
acquired using a Hypack line plan originally created in MapInfo. 
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Paint-the-Bottom – The paint-the-bottom scheme is used during complete or object detection 
MBES operations.  Unlike a traditional line-plan approach, paint-the-bottom is an adaptive line-
steering technique, whereby the coxswain viewed a real-time coverage map in Hysweep and 
accordingly adjusted line steering to ensure adequate overlap.  Because of the operational 
efficiency afforded by the real-time coverage map, holidays, or gaps in the coverage, are often 
addressed the same day.  When holidays are not addressed the same day, they were acquired 
based on a traditional line plan.  The coxswain strove to avoid abrupt changes in direction and 
speed, but abrupt changes in direction and speed were unavoidable in certain areas due to current 
and/or confined areas.  In areas were abrupt changes in direction were unavoidable speed was 
reduced to minimize motion-related artifacts.   
 
Developments 
The intent of development operations is to obtain the least depth of a particular feature or shoal. 
Development data are acquired using a pattern of tightly spaced short lines that are run with 
enough overlap to ensure the least depth comes from the near-nadir region of the swath.  
Developments can be run for features originally identified in either SSS or MBES data. 

B.1.1.2. Sound Speed Profiles 
Sound speed casts were acquired as per HSSD section 5.2.3.3.  Although sound-speed correctors 
are applied in CARIS post processing (see section B.1.2.2), casts were often loaded in SIS for the 
cosmetic purpose of minimizing refraction artifacts in the real-time display.   

B.1.2. Processing Workflow 
Multibeam processing was based on the BASE surface/directed-editing paradigm described in 
FPM section 5.2, Bathymetry Processing.  The multibeam processing workflow had three main 
components:  preliminary processing, surface generation, and surface review/data cleaning (see 
Fig. 19).  Note that the surface generation and surface review/data cleaning steps are iterative. 
 

 

B.1.2.1. Preliminary Processing 
Preliminary processing consisted of converting the raw, SIS-logged .all data to CARIS HDCS 
format, applying a number of correctors via the Apply Tides, Apply SVP, and Merge functions, 
and calculating a priori horizontal and vertical total propagated uncertainties (TPU) for each 
sounding.  Each is described below. 
 

Preliminary 
Processing 

Surface 
Generation 

Surface Review/ 
Data Cleaning 

 Evaluate coverage 
(gaps & density) 

 Evaluate systematic & 
non-systematic errors 

 Designate soundings 
 SSS contact 

correlation

 Specify CUBE 
parameters 

 Finalize  
 

 Convert .all files 
 Apply SVP 
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Figure 19:  Multibeam Processing Workflow
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Conversion 
Raw multibeam .all data were converted to HDCS format in CARIS HIPS.  As noted in section 
A.2.1.1, the overall MBES acquisition system is configured such that three main datagrams are 
converted into CARIS: 
 

 ZDA-synchronized position of the vessel RP 
 ZDA-synchronized attitude of the vessel RP 
 roll-stabilized raw angles and ranges 

 
The real-time ray-traced depths are also converted into CARIS (as the observed depths), but 
these data are overwritten during SVP correction to generate new observed depths using the 
appropriate sound-speed profiles. 
 
Applying SVP 
The SVP-correction process in CARIS generates ray-traced along-track and across-track depths 
relative to the sonar head (the observed depths).  To achieve accurately ray-traced depths, the 
SVP algorithm positions the transducer at the proper depth and orientation in the water column 
by applying the attitude (including delayed heave), dynamic draft, water line, and RP--to--
transducer-lever-arm correctors.  Typically, multiple SVP casts are concatenated into a single 
file, with an appropriate cast-selection method specified during SVP correction.  The “nearest in 
distance within time” option is generally used, but the distribution of casts occasionally calls for 
another cast-selection method. 
 
Appling TCARI Tides 
The data were tide corrected in Pydro using the TCARI grid from CO-OPS. The grid utilizes 6-
min MSL tide data (predicted, preliminary, or verified) for each station in the survey area. When 
run, Pydro creates tidal reducers for the HDCS lines and places the data in each line folder. Any 
data points outside the TCARI grid will generate an error report that can be saved for future 
reference. Once this process is complete the data should be merged. 
 
Merging 
The merge process in CARIS combines the observed depths (updated during SVP correction) 
with the loaded tide file, the navigation data, and the HVF swath1 angular offsets (patch test 
values) to compute the final processed depths. 
 
Computing TPE 
The TPE computation process assigns each sounding a horizontal and vertical uncertainty, or 
estimate of error, based on the uncertainties of the various data components, such as position, 
sound speed, and loading conditions.  Table 2 lists the HVF TPE values used for S1211 MBES 
data. 
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Table 2:  TPE Values 

Data Component TPE Value Data Component TPE Values 
Motion Gyro 0.02° X, Y, & Z Offsets 0.001 m 
Heave % Amplitude 5% Vessel Speed 0.03 m/s 
Heave  0.05m Loading 0.01 m 
Roll 0.02° Draft 0.03 m 
Pitch 0.02° Delta Draft 0.03 m 
Position Nav 0.5m MRU Align StdDevgryo 0.2° 
Timing Transducer 0.01 s MRU Align StdDev Roll/Pitch 0.05° 
Nav Timing 0.01 s Sound Speed Surface 0.5 m/s 
Gyro Timing 0.01 s Sound Speed Profile 2 m/s 
Heave Timing 0.01 s Tide measured n/a* 
Pitch Timing 0.01 s Tide zoning n/a* 
Roll Timing 0.01 s   

 *tide uncertainly is incorporated into the TCARI model 

B.1.2.2. Surface Generation 
The multibeam sounding data were modeled using the CUBE BASE surface algorithm 
implemented in CARIS HIPS.  CUBE BASE surfaces were generated using the parameters 
outlined in Hydrographic Surveys Technical Directive 2009-02 (CUBE Parameters).  The 
resolutions of the finalized surfaces were based on the complete MBES coverage resolution 
requirements specified in the Specs and Deliverables (5.2.2.2).  The deeper limit of certain 
ranges was extended to avoid gaps between surfaces on particularly steep slopes.  Surfaces are 
finalized with the “Greater of the Two” option, to maintain a conservative error estimate. 

B.1.2.3. Surface Review/Data Cleaning 
Rather than a traditional line-by-line review and a full subset-cleaning, the data cleaning/quality 
review process forOPR-K414-NRT4-14consisted of a combination of the directed-editing 
approach described in FPM section 5.2 and a full subset-review (not full subset-cleaning).  All 
the sounding data were viewed in subset, but unlike in the traditional workflow, where every 
sounding deemed to be “noise” is rejected, only the soundings that negatively impacted the 
CUBE surface were rejected.  Surface review also consisted of evaluating holidays (both 
coverage and density holidays) and systematic errors and designating soundings.  Sounding 
designation was in accordance with Specs and Deliverable section 5.2.1.2.  
 
In general, the hydrographer referenced the SSS data when cleaning MBES data and designating 
soundings.  In situations where the MBES data were ambiguous, consulting the SSS data often 
helped to determine a course of action.  If consulting SSS data did not resolve the issue, more 
MBES were acquired over the item in question. 
 

B.2. Sidescan Sonar Data 

B.2.1. Acquisition Operations 
The SSS towfish was deployed from a davit arm located on the starboard quarter using a Dayton 
electric-hydraulic winch spooled with approximately 25 meters of cable.  The tow cable at the 
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winch was connected electro-mechanically to a deck cable through a slip ring assembly.  Cable 
out was controlled manually and was computed by the DynaPro cable counter by the number of 
revolutions of the cable drum sheave. Cable-out was adjusted to 4.0 meters before deployment of 
the towfish to account for the distance from the towfish-to-towpoint, which was defined to be the 
top of the sheave. 
 
Line spacing for side scan sonar (SSS) operation was prepared as directed in the NOAA Field 
Procedures Manual and Spec’s and Deliverables. To minimize towing gear stress, and reduce 
strumming, towed SSS operations were typically limited to approximately 6 knots speed-over-
ground.  During left turns, speed was increased (after ensuring adequate cable out) to prevent the 
tow cable from swinging into the outboard propellers; the higher speed created a force on the 
cable that kept the cable at a safe distance from the outboard propellers.  A towfish altitude of 8-
20% of the range scale was maintained during data acquisition.  Altitude was adjusted by cable 
out and vessel speed. 
 
Confidence checks were performed daily by observing changes in bottom features extending to 
the outer edges of the digital side scan image, features on the bottom in survey area, and by 
passing aids to navigation. Daily rub tests are also conducted. 
 

B.2.2. Processing Workflow 
Sidescan processing was based on the boat-day concept documented in section 4.3 of the Field 
Procedures Manual (Imagery Processing).  The sidescan processing workflow had three main 
components (see Fig. 20):  preliminary processing, mosaicking, and contact selection.  Feature 
classification and correlation is addressed in section B.3, “Feature Data.” 
 

 

B.2.2.1. Preliminary Processing 
Preliminary processing consisted of conversion, slant-range correction, AVG/TVG correction, 
and towfish navigation computation. 
 
Conversion 
Raw sidescan .sdf data were converted to HDCS format in CARIS HIPS/SIPS.  The overall SSS 
acquisition system is configured such that vessel navigation, vessel gyro, towfish depth, towfish 
altitude, cable out, and raw sidescan data are converted into CARIS SIPS. 
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 AVG & TVG 

Correction 
 

Figure 20:  Sidescan Processing Workflow
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Slant-range Correction 
Slant-range correction is no longer an element in the SSS processing workflow as CARIS 8.1 
automatically makes this calculation during the Conversion process or “on-the-fly” should the 
seabed trace require editing, after conversion. 
 
AVG/TVG Correction 
As documented in the CARIS HIPS & SIPS User Guide, AVG and TVG correct for variations in 
backscatter intensity due to the angle of incidence and travel time, respectively, of the return.  
 
Towfish Navigation Computation 
Towfish navigation was calculated in CARIS SIPS, which uses the “follow-the-dog” 
algorithm(see CARIS HIPS & SIPS 7.0 Users Guide).  During this computation, the towfish 
depth, cable out, HVF Tow Point Z-value, and vessel course-made-good are used to calculate the 
towfish position.  Contact positions were recomputed whenever towfish navigation was 
recomputed. 

B.2.2.2. Mosaicking 
After creating a Field Sheet, mosaics of varying resolution and bin parameters are created.  Note: 
it is no longer necessary to generate “GeoBars” in advance to mosaicking in CARIS 8.1. 

B.2.2.3. Contact Selection 
Sidescan contacts were selected as per the Specs and Deliverables section 6.3.2 and the Field 
Procedures Manual section 4.3.4.1.  Once selected, contacts were exported from CARIS, 
including a speed-corrected, geo-referenced, and raw image of the contact.  The shadow-height 
field for every contact was populated, but the length, width, and remarks field were populated 
only when deemed informative by the hydrographer. 
 

B.3. Feature Data 
General feature management consisted of two main workflows (see Fig. 21):  Pydro features and 
Non-Pydro features.  The distinction between the Pydro and Non-Pydro workflows is due to 
different acquisition procedures and processing capabilities.  Whereas Pydro features are point 
features derived from the bathymetry data or vessel navigation data (e.g., DPs), Non-Pydro 
features are point, line, or area features typically acquired using a Trimble GeoXH GPS or 
digitized from an orthophoto, CUBE surface, or mosaic.  The spatial feature type (point versus 
line or area) is important because Pydro does not have the capability to easily manipulate line 
and area features.   
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B.3.1. Pydro Feature Workflow 

B.3.1.1. Pydro Feature Types 
Pydro features consist of bottom samples, designated soundings, sidescan contacts, GPs, and 
AWOIS items. 

Bottom Samples 
Bottom sample features were created in CARIS Bathy Database.  SBDARE point features were 
created at the position of each bottom sample and then attributed with the appropriate 
NATSUR/NATQUA attributes.  The SBDARE features were then exported to a .000 file and 
imported into PYDRO for inclusion in the feature file deliverable. 

Designated Soundings 
The least depth of charted features and significant uncharted features were flagged “designated” 
in CARIS HIPS to ensure that the depth is portrayed in the final BASE surface.  Soundings that 
were flagged designated were then imported into PYDRO as bathy features.  Once in PYDRO, 

Figure 21:  Feature Management Workflow
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these bathy features were then correlated with other features and given the appropriate S-57 
attribution.   

Sidescan Contacts 
Sidescan contacts were selected as per the HSSD section 6.3.2 and the Field Procedures Manual 
section 4.3.4.1.In an effort to guide the contact selection process in areas with a high density of 
features, the hydrographer also applied the generalization logic for designated soundings (HSSD 
5.2.1.2) to sidescan contact selection.  Once selected, contacts were exported from CARIS, 
including a speed-corrected, geo-referenced, and raw image of the contact.  The shadow-height 
field for every contact was populated, but the length, width, and remarks field were populated 
only when deemed informative by the hydrographer. 

Chart GPs 
Pertinent ENC features were added to the Pydro PSS (Pydro Survey Session) as chart GPs 
(geographic positions), as a convenient way to manage and correlate already-charted features. 

AWOIS 
The AWOIS items received as part of the project instruction package are inserted into the Pydro 
PSS as AWOIS features. 

Detached Positions (DPs) 
Detached positions are features the position of which is calculated from a range and bearing from 
the vessel reference point.  Typically, DPs are created by first creating a target in the Hypack 
Survey program and then applying the range and bearing to that target via a function built into 
Pydro. 
 

B.3.1.2. Pydro Feature Processing 
Feature processing in Pydro consisted of three main steps:  correlation, attribution, and export. 

Feature Correlation 
Feature correlation consisted of establishing the primary/secondary relationships among the 
various feature types for a given real-world item.  For example, for a real-world item (e.g., a 
shipwreck) that was represented in the PSS by a bathymetry feature, multiple sidescan contacts, 
an ENC chart GP, and an AWOIS feature, the bathy feature was given a status of ‘primary’, and 
all the other, or correlating, features were given a status of ‘secondary’. 

Feature Attribution 
Feature attribution consisted of two main steps.  First, the primary feature for a given reportable 
real-world item would have been given a combination of Pydro flags according to one of the four 
appropriate DR templates:  DR_DtoN, DR_AWOIS, DR_Charted, and DR_Uncharted (see 2010 
FPM section 4.4.8.1).  Second, each primary reportable feature was given S-57 attribution using 
Pydro’s S-57 Editor. 

Feature Export 
After all features were correlated and attributed, the “Report” feature set (i.e., the field-verified 
CSF) is exported from Pydro to an S-57 .000 file. 
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B.3.2. Non-Pydro Feature Workflow 

B.3.2.1. Non-Pydro Feature Types 
Non-Pydro features consist of GPS features (GPs acquired with a hand-held or pole-mounted 
GPS) and digitized features. 

GPS Features 
All GPS features are collected using an S-57 data dictionary installed on a GeoXH handheld.  A 
minimum of 10 minutes of carrier-phase lock on point features and the initial vertex of line and 
area features.  For each subsequent vertex of line and area features, 2-minute observations are 
obtained.  A GPS position is collected once every 5 seconds throughout each observation.   
 
GPS data are post processed in Trimble Pathfinder using the H-Star processing routine, typically 
set to use a single base provider.  Once the GPS shoreline feature data are post-processed, the 
feature data are exported from Pathfinder as a shapefile and then imported into either CARIS 
Bathy Database or Hypack ENC Editor (see section B.3.2.2). 

Digitized Features 
In CARIS Bathy Database, features can be digitized from CUBE surfaces, sidescan mosaics, or 
orthophotos.  Examples of features digitized from surfaces and mosaics include pipelines, piers, 
and rocky seabed areas.  In general, it is not accepted practice to digitize features from 
orthophotos, but in select circumstances, the hydrographer will do so.  This practice is done only 
in situations when doing so (1) results in positional and/or semantic accuracy much greater than 
what is currently charted and (2) helps clarify the treatment of regular Pydro and Non-Pydro 
features.  For example, the extents of a mischarted barrier island would be digitized from an 
orthophoto if bathymetry data were acquired over the charted land area.  Additional criteria are 
that the orthophoto has reliable metadata (including source, resolution, and acquisition date) and, 
in the case for shoreline, that the desired information cannot be obtained from a contemporary 
National Geodetic Survey (NGS) shoreline survey. 

B.3.2.2. Non-Pydro Feature Processing 
Non-Pydro features are processed in either CARIS Bathy Database or Hypack ENC Editor.  Both 
programs allow a user to create and edit S-57 features.  Once the S-57 features are topologically 
correct and appropriately attributed, the resulting .000 file is inserted into Pydro as a reference. 
 
 
C. CORRECTIONS TO ECHO SOUNDINGS 

The following section describes the determination and evaluation of the three main categories of 
corrections to echosoundings: vessel, sound speed, and water level correctors. 

C.1. Vessel Correctors 
Vessel correctors include static offsets, dynamic offsets, and patch test biases.  The various 
correctors are applied to echo soundings at different points throughout the data pipeline. 
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C.1.1. Static Offsets 

C.1.1.1. Vessel Lever-Arms 
The RP-to-EM3002 lever arm was measured using a tape measure on 2/12/14, in Galveston, TX, 
while the boat was on the trailer in a parking lot (see Fig. 20).  The height of the static draft 
reference plane above the parking lot was determined by taking the average of the heights of the 
port and starboard static draft reference points.  The height of the EM3002 above the parking lot 
was determined by taking the average of the heights of the port and starboard sides of the 
transducer. 
 
 
 

 

C.1.1.2. Static Draft 
A static draft check was performed on February 7, 2014 in the parking lot of the NOAA Flower 
Garden Banks Marine Sanctuary facility, Galveston, TX.  The draft check was accomplished as 
the vessel lay stationary and level on its trailer.  This unconventional, yet practical measurement 
method exploited the occurrence of a well-defined, 2.1cm wide scum line distinctly evident 
along S1212’s hull. The scum line (scum “area,” more precisely) encompassed the full range of 
water lines derived from variations in vessel loading; i.e. fuel level, equipment, supplies, 
personnel, etc. while at rest.  The “actual” water line was taken to be the center of this 2.1 cm 
scum line .See Fig. 22.1. 
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Figure 22:  RP-to-Transducer Lever Arm Measurement
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Figure.22.1 

 
To determine the static draft (i.e., the height of the waterline above/below the reference point), 
two new benchmarks and an easily repeatable method were established.  A benchmark (BM) was 
established on the port and starboard rub-rails, closely aligned with the reference point (RP)in 
the along-ship dimension (see Fig. 21). 
 
First, a pipe was placed athwartship, over the RP, to provide a reference line that could be used 
to tie the benchmarks into the vessel coordinate frame (see Fig. 20).  The pipe was assumed to be 
straight and orthogonal to the z-axis of the vessel coordinate frame.  The vertical offset (relative 
to the RP) of each benchmark was calculated by subtracting the waterline-to-pipe distance from 
the RP-to-pipe distance. 
 

 
 
 
 

Figure 23:  Waterline Benchmarks

2.1cm 
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Next, graduated ruler measurements from BM-to-WL and BM-to-Pipe were taken to further 
authenticate the Pipe-to-WL distance made in the first step.  Averages of these port and starboard 
dimensions were added together reconfirming the average WL heightof 0.742m (Green callout 
box, Fig. 24.) Accordingly, theseparation value of 0.079m between IMU and WL was 
successfully reproduced.   
 
 
 
 
 
 
 
 
 
 
 
 
Finally, an induced heave value was subtracted from the preliminarywaterline value to account 
for a non-zero static pitch during the measurements (see Fig. 22).  The induced heave (calculated 
assuming the vessel center of rotation was level with the water surface) was estimated by 
multiplying the along-ship component of the heave lever arm by a nominal pitch value noted at 
the time of the waterline measurements.  The waterline calculations are summarized in Table 3. 
 

 
 
 

Table 3:  S1211 Waterline Value 

Uncorrected WL Induced Heave Due to Static Pitch Corrected WL 
-0.079 0.072 m -0.007 m 

 
In the interest of continuity, the Acting Team Leader deemed the above 2012 Field Season draft 
values adequate for a project which has spanned several field seasons. 
 

Figure 25:  Static Draft Induced Heave
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Figure 24:  Waterline Measurements
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C.1.2. Dynamic Offsets 
Dynamic draft was measured using the ellipsoidally referenced dynamic draft model 
(ERDDM)method, described in Appendix 4 of the 2014 Field Procedures Manual.  The test was 
performed on DN142 during a moderately smooth sea state in the vicinity of Galveston Channel.  
A “single-base” PPK solution was based on the TXGA CORS station.Results were attained by 
invoking Pydro script “ProcSBETDynamicDraft.py” and using the Polynomial-fit order of “4rd 
Order.”  See Figure 26. 
 

 
Figure 26:  ERDDM SBET from Pydro Macro “ProcSBETDynamicDraft.py” 
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Figure 27:  Dynamic Draft Comparison, 2014 vs prior years 

The results were compared to 2012and 2013 values(see Fig. 26).   Although vessel loading and 
equipment configurations had not changed significantly from prior years, the resulting Draft vs. 
Speed profile compared poorly to historic trends.  Possible factors contributing to overall 
uncertainty may have been due to variable winds and undocumented currents within the 
Galveston Channel.  In the interest of continuity, the Team Leader chose to reject the most recent 
dynamic draft values as the project OPR-K414-NRT4-GalvestonBay will span several survey 
seasons.  Thus, Dynamic draft values from 2013 were retained in CARIS hydrographic vessel 
file (.hvf).  

C.1.3. Patch Test Biases 
A patch test was performed on 3/21/2014, in the vicinity of Bolivar Roads, near Galveston, TX 
(see Fig. 26).The navigation timing error was determined using the traditional method requiring 
running a pair of lines over a target, not the “precise-timing” method requiring running a single 
line in a flat area.  Each team member processed the patch test to obtain individual results.  The 
individual results were then averaged (see Table 5), and the averages were then entered into the 
Swath1 sensor of the HVF. 
 

Table 4:  Patch Test Values  

Individual 1 Individual 2 Individual 3 Individual 4 Average StdDev 

Timing 0.00 0.00 0.00 0.00 0.00 0.00 

Pitch 0.00 0.00 0.00 0.00 0.00 0.00 

Roll 0.22 0.33 0.35 0.41 0.328 0.08 

Heading 0.10 0.50 0.20 0.47 0.318 0.20 
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Figure 28:  Patch Test Location, Chart 11324 (Charted depths are in feet) 

 
 
 

C.2. Sound Speed 
As discussed in sections B.1.1.2 and B.1.2.1, sound-speed corrections are applied in CARIS 
post-processing.  Sound-speed corrector files (.svp files) are generated by the NOAA software 
Velocipy v14.6 (installed on the boat day number 171). 

C.3. Water Level Corrections 
NRT4uses three different water-level-correction paradigms – discrete zoning, TCARI, or, less 
commonly, ellipsoidally referenced surveys (ERS).  Refer to a particular Descriptive Report for 
details regarding a specific survey.   

C.3.1. Discrete Zoning 
As per procedures described in the Field Procedures Manual, preliminary and final discrete tide 
zoning files are obtained from CO-OPS.  Any desired predicted, preliminary, or verified water 
level data are downloaded from the internet via the HSTP program Fetch Tides and loaded to the 
HDCS line folders using the CARIS HIPS load-tide function.  Any associated zoning-uncertainty 
is typically included in the final tide note. 
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C.3.2. TCARI 
TCARI (Tidal ConstituentAndResidual Interpolation) refers to the method of generating water-
level correctors by interpolating the harmonic constituent, datum-separation, and residual data 
froma network of nearby water-level gauges.  As with the discrete zoning paradigm, water level 
data are downloaded using FetchTides; however, water level correctors are loaded to the HDCS 
line folders via Pydro, the software in which the TCARI functionality is embedded. 

C.3.3. Ellipsoidally Referenced Surveys (ERS) 
Ellipsoidally referenced surveys are conducted as per Office of Coast Survey ERS standard 
operating procedures (see Appendix 4 of the 2012 Field Procedures Manual).  Under an ERS 
paradigm, ellipsoidally referenced soundings are reduced to chart datum based on an 
ellipsoid/chart datum separation model, which can range in complexity, based on the local chart 
datum and size of the survey area.If the survey area is not close enough to existing NGS base 
stations (CORS) to use either a single station or network of stations, a project-specific GPS base 
station is established.  Refer to a specific project’s Horizontal and Vertical Control Report for 
details regarding the ERS processing for a particular survey. 
 
  





Appendix 1 – Sound Speed Equipment Calibration Reports 



Service

Customer Information:

Report

Company NOAA/NRT4 Date 1/20/2014

Contact Luke Pavilonis

PO Number TBD

RMA Number 77689

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Serial Number 19P38684-4674

Model Number SBE 19Plus

Services Requested:

1.  Evaluate/Repair Instrumentation.
2.  Perform Routine Calibration Service.

Problems Found:

Services Performed:

1.  Performed initial diagnostic evaluation.
2.  Calibrated the pressure sensor.
3.  Performed "Post Cruise" calibration of the temperature & conductivity sensors.
4.  Performed complete system check and full diagnostic evaluation.

Special Notes:

Monday, January 20, 2014 Page 2 of 2



Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4674

CALIBRATION DATE: 14-Jan-14

SBE19plus TEMPERATURE CALIBRATION DATA

ITS-90 TEMPERATURE SCALE

ITS-90 COEFFICIENTS

a0 =  1.152358e-003

a1 =  2.764918e-004

a2 = -1.206683e-006

a3 =  1.916742e-007

 BATH TEMP  INSTRUMENT  INST TEMP  RESIDUAL

 (ITS-90)   OUTPUT(n)     (ITS-90)  (ITS-90)

 1.0000  691071.593  1.0001  0.0001

 4.5000  618146.797  4.4999  -0.0001

 15.0000  433793.898  15.0002  0.0002

 18.5000  383429.153  18.4999  -0.0001

 24.0000  314411.373  24.0000  0.0000

 29.0000  261357.085  28.9999  -0.0001

 32.5000  229077.983  32.5001  0.0001

MV = (n -  524288) / 1.6e+007

R = (MV * 2.900e+009 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + a1[ln(R)] + a2[ln
2

(R)] + a3[ln
3

(R)]} - 273.15 (°C)

Residual = instrument temperature - bath temperature
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Sea-Bird Electronics, Inc.
13431 NE 20th Street, Bellevue, WA 98005-2010 USA

Phone: (+1) 425-643-9866 Fax (+1) 425-643-9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4674

CALIBRATION DATE: 13-Jan-14

SBE19plus PRESSURE CALIBRATION DATA

 160 psia S/N 5820

COEFFICIENTS:

PA0 =  7.597399e-002

PA1 =   4.910604e-004

PA2 =  -4.240432e-012

PTEMPA0 = -6.711277e+001

PTEMPA1 =  5.151236e+001

PTEMPA2 = -5.100431e-001

PTCA0 =  5.251804e+005

PTCA1 =  1.338446e+001

PTCA2 = -2.793070e-001

PTCB0 =  2.493250e+001

PTCB1 =  1.300000e-003

PTCB2 =  0.000000e+000

 PRESSURE SPAN CALIBRATION  THERMAL CORRECTION

 PRESSURE  INST   THERMISTOR  COMPUTED  ERROR  TEMP  THERMISTOR  INST

 PSIA  OUTPUT    OUTPUT  PRESSURE  %FSR  ITS90  OUTPUT  OUTPUT

  14.84 555455.0  1.8  14.84  0.00  32.50  1.97  556105.90

  30.14 586630.0  1.8  30.12  -0.01  29.00  1.90  556104.36

  60.11 647829.0  1.8  60.09  -0.01  24.00  1.80  556116.49

  95.11 719397.0  1.8  95.10  -0.01  18.50  1.69  556109.04

 125.11 780810.0  1.8  125.11  -0.00  15.00  1.62  556101.45

 160.12 852524.0  1.8  160.11  -0.00  4.50  1.41  556019.27

 125.11 780845.0  1.8  125.13  0.01  1.00  1.34  555966.50

  95.12 719451.0  1.8  95.13  0.01

  60.12 647885.0  1.8  60.12  0.00  TEMP(ITS90)  SPAN(mV)

  30.14 586690.0  1.8  30.15  0.01   -5.00   24.93

  14.84 555457.0  1.8  14.84  0.00   35.00   24.98

y = thermistor output; t = PTEMPA0 + PTEMPA1 * y + PTEMPA2 * y
2

x = pressure output - PTCA0 - PTCA1 * t - PTCA2 * t
2

n = x * PTCB0 / (PTCB0 + PTCB1 * t + PTCB2 * t
2

)

pressure (psia) = PA0 + PA1 * n + PA2 * n
2
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Customer: NOAA/NRT4

Job Number: 77689

Model Number: SBE 19Plus

Date of Report: 1/14/2014

Serial Number: 19P38684-4674

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/14/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00070 Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER REPAIR' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since Degrees Celsius/yearDegrees Celsius/yearDegrees Celsius/yearDegrees Celsius/year

Comments:Comments:Comments:Comments:

Last cal:Last cal:Last cal:Last cal:

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift.  If 

the calibration identifies a problem, then a second calibration is performed after work is completed.  The 'as received' 

calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received' calibration certificate is provided, listing coefficients to convert sensor frequency to temperature.  Users 

must choose whether the 'as received' calibration or the  previous calibration better represents the sensor condition 

during deployment.  In SEASOFT enter the  chosen coefficients.  The coefficient 'offset' allows a small correction for 

drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a repair apply only to 

subsequent data.

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Temperature Calibration Report



Service

Customer Information:

Report

Company NOAA/NRT4 Date 1/20/2014

Contact Luke Pavilonis

PO Number TBD

RMA Number 77689

SEA-BIRD ELECTRONICS, INC.
13431 NE 20th St. Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Serial Number 05M0721

Model Number SBE 05M

Services Requested:

1. Evaluate/Repair Instrumentation.

Problems Found:

Services Performed:

1. Performed initial diagnostic evaluation.

Special Notes:

Monday, January 20, 2014 Page 1 of 2



SEA-BIRD ELECTRONICS, INC.
13431 NE 20th Street Bellevue, Washington 98005 USA

Phone: (425) 643-9866   Fax: (425) 643-9954  www.seabird.com

Conductivity Calibration Report

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of 

sensor drift.  If the calibration identifies a  problem or indicates cell cleaning is necessary, then a second calibration is 

performed after work is completed.  The 'as received' calibration is not performed if the sensor is damaged or non-

functional, or by customer request.

Customer: NOAA/NRT4

Job Number: 77689

Model Number: SBE 19Plus

Date of Report: 1/14/2014

Serial Number: 19P38684-4674

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to 

conductivity. Users must choose whether the 'as received'  calibration or the previous calibration better  represents the 

sensor condition during  deployment.  In SEASOFT enter the chosen coefficients.  The coefficient 'slope' allows small 

corrections for drift between calibrations (consult the SEASOFT manual).  Calibration coefficients obtained after a 

repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: 1/14/2014 Drift since last cal:Drift since last cal:Drift since last cal:Drift since last cal: -0.00050 PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' PerformedPerformedPerformedPerformed Not PerformedNot PerformedNot PerformedNot Performed

Date:Date:Date:Date: Drift sinceDrift sinceDrift sinceDrift since PSU/month*PSU/month*PSU/month*PSU/month*

Comments:Comments:Comments:Comments:

Cell cleaning and electrode replatinizing tend to 'reset' the conductivity sensor to its original condition.  Lack of drift in 

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

*Measured at 3.0 S/m

Last cal:Last cal:Last cal:Last cal:















Appendix 2 – Hydrographic Inventory 



Hydrographic Software Inventory
Field Unit:  NRT4

LAPTOP
ERIN

DAN
LUKE

ACQUISITION
DAN - DECOMISSIONED 5/19/2014

COMPUTERS
CD#

CD0001762483
CD0004101898

CD0004101849
CD0001772612

CD0004098574
CD0001670316

Machine Nam
e

OCS-L-NSD762483
OCS-W

-004101898
OCS -W

-004101849
OCS-W

-001772612
OCS-W

-004098574
OCS-W

-001670316
Operating System

W
indows XP

W
indows 7 (64-bit) (rebuilt XP)

W
indows 7 (64-bit)

W
indows 7 (64-bit)

W
indows 7

W
indows 7 (64-bit)

Location
Office

Office
Office

Office 
Boat

Office
Type

Laptop
W

orkstation
W

orkstation
W

orkstation
W

orkstation
W

orkstation
Make/Model

Dell Latitude D630
Dell Precision 1650

Dell Precision T1650
Dell Precision T3500

Dell Precision T5500
Dell Precision T3500

Date Purchased 
4/21/2008

9/2/2011
1/1/2014

7/1/2011
1/1/2014

7/1/2011
Processor

Core 2 Duo 2.5 GHz
Core2Quad; Q9550@

2.83GHz
Xeon® E31240 @

 3.40GHz
Intel® Xeon® W

3550@
3.07GHz

Intel® Xeon ®
Intel® Xeon® W

3550@
3.07GHz

RAM
3.5GB

3070MB
16GB

6.00 GB
6.00 GB

Video Card
NVIDIA Quadro NVS 135M

NVIDIA Quadro NVA 420
NVIDIA Quadro 600

NVIDIA Quadro NVS 420
Video RAM

256 MB
512MB

1GB
512 Mb

Service Tag
3HW

M3G1
BX1BVK1

G8Q68Y1
63T0XQ1

3ZKZXQ1
SOFTW

ARE
Acquisition

Hypack
n/a

n/a
n/a

n/a
v12.0.0.2

n/a
Klein Sonar Pro

n/a
n/a

n/a
n/a

v12.1 (build 135)
n/a

Kongsberg SIS
n/a

n/a
n/a

n/a
v3.8.3 (Build 89)

n/a
Trimble TSIP

n/a
n/a

n/a
n/a

n/a
n/a

POS/MV Controller
n/a

n/a
n/a

n/a
n/a

n/a
Velocwin

n/a
n/a

n/a
13.8

n/a
n/a

Processing

Caris HIPS & SIPS
v8.1.7

v8.1.7  (CW
9604695, CK9606721)

v8.1.7  (CW
9604695, 

CK9606721)
v8.1.7  (CW

9604695, CK9606721)
n/a

v8.1.7  (CW
9604695, CK9606721)

ESRI ArcMap
10.2

10.2
10.2

10.2
n/a

10.2

Trimble Terrasync
n/a

n/a
n/a

v5.02
Trimble Pathfinder

n/a
n/a

n/a
v5.1.0

Ancillary
Caris BASE Edito r

v4.0
v4.0

v4.0
n/a

v4.0

Pydro
v10.11 (r3191) 

2feb236caae8128f46
v13.8 90a172fbdd2de80357

v13.8 90a172fbdd2de80358
v13.8 5402cbe713a33f5318

n/a
 v13.2 (r4380) 6b8078572f560882c6

MapInfo
v11; s/n MINW

EU1000051174; 
Access Code 403600

v11.5.1 ; s/n 
MINW

EU1150111986; Access 
Code 396817

v11.5.1 ; s/n 
MINW

EU1150111986; Access 
Code 396818

v11.5
n/a

v11; s/n MINW
EU1050071593; Access 

Code 395389

Fledermaus
n/a

v7.2
v7.3

v7
n/a

n/a



Hydrographic Hardware Inventory
Field Unit:  NRT4

Equipm
ent Type

M
anufacturer

M
odel

Serial Num
ber

Firm
ware

Date of Last 
Calibration

Com
m

ents

SONAR AND SOUNDING EQUIPMENT
Multibeam

 Echosouner
Kongsberg

EM3002
Head=753 (pre 5/6/11) 
& 796 (post 5/6/11); 
PU=668

PU=2.0.23; Head=3.0.3
n/a

Side Scan Sonar
Klein

System 3000
TPU=314; Fish=498 
(pre 5/27/11) & 413 
(post 5/27/11)

vxW
orks=5.4.2

n/a
being 
excessed, 
FY2014

Edgetech
Edgetech

4125
Topside=40260, 
Fish=40423

Discovery II version 2
n/a

Vertical Beam
 Echosounder

Odom
Echotrac CV-200

23005
1

n/a

POSITIONING & ATTITUDE EQUIPMENT
GPS-Aided Inertial Navigation

Applanix
POS/MV 320 V4

PCS-, IMU-3245?
POS=5.03,GPS 
Rx=4.21

IMU tumbled 3/1/12; 
GAMS on 6/22/12

DGPS Reciever
Trimble

DSM312
224091110

V 1.73
n/a

GPS Receiver
Trimble

GeoXH 2008
4928419526

v2.11
n/a

SOUND SPEED MEASUREMENT EQUIPMENT
Sound Speed Profiler

Seabird
SeaBird CTD

4674
n/a

7-Feb-12
Sound Speed Profiler

Odom
DigibarPro

98150
n/a

23-Aug-12
Sound Speed Profiler

Odom
DigibarPro

98351
n/a

27-Jul-12
Sound Speed Profiler

AML
Micro X

10321
n/a

1-Jan-14
TIDES & LEVELING EQUIPMENT
Optical Level

Sokkisha
B1 Automatic

4968
n/a

1/11/2012
Level Rod

Mound City
903086

7890-2-45
n/a

n/a



NOAA NRT-4 OPR-K414-NRT4-12 DAPR 

Appendix 3 – Dynamic Draft 







Appendix 4 – Level Collimation Check Log 



Appendix 5 – Wiring Diagram 
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Cable End1 End2 Settings Description
L1 Hypack Computer 

129.100.1.230 
255.255.0.0 

Network Switch n/a Connects to SonarPro Computer and 
POS/MV 

L2 POS/MV 
192.168.53.100           
255.255.0.0 

192.168.53.101 
Port 5602 UDP broadcast of depth, attitude, & 

PosPac data to Hypack  
(3,7,102@2Hz) 

L3 EM3002 
157.237.2.61 
255.255.0.0 

Hypack Computer 
157.237.2.60 
255.255.0.0 

Port 16101 UDP broadcast of  various EM 
datagrams 

L4 Edgetech 
192.9.0.101 
255.255.255.0 

Hypack Computer 
192.9.0.100 
255.255.255.0 

n/a SSS data stream (crossover) 

S1 POS/MV 
Com 1 

EM3002 PU 
Com 1 

9600,n,8,1 Position data to EM3002 (GGA) @ 1 
Hz 

S2 POS/MV 
Com 2 

EM3002 PU 
Com 2 

19200, n,8,1 Attitude data to EM3002 (Simrad 
3000 TSS) @ 100 Hz 

S3 Digibar Hypack Computer 
Com 3 

9600,8,n,1 Surface sound speed to SIS for 
EM3002 beam forming/steering 

S4 Trimble DGPS 
Port A 

POS/MV 
Com 3 

9600, n,8,1 RTCM DGPS correctors to POS/MV 

S5 Cable Counter SonarPro Computer 
Com 6 

2400,7,n,1 Cable out from Dynapar unit to 
Hypack Computer 

S6 Hypack Computer 
Com8 

Hypack Computer 
Com9 

Compatibility Utility, 2700 baud to 
9600 baud 

S7 Seabird SBE 19+ Hypack Computer 
Com 1 

9600,8,n,1 Download CTD cast data 

S8 AML Micro X Hypack Computer 
Com 7 

9600,8,1,n Surface sound speed to SIS for 
EM3002 beam forming/steering 



Appendix 6 – SIS PU Settings 









































Saved: 2014.09.23 16:22:52

Sounder Type: 3020, Serial no.:  796

Date       Time          Ser. No.    BIST      Result
-----------------------------------------------------------------
-------------------
1980.01.04 10:24:39.753  796 1 OK
EM3002
HCT test ok

-----------------------------------------------------------------
-------------------
1980.01.04 10:24:40.059  796 2 OK
EM3002
DIGITAL +5V(+/- 0.25V) =  4.95V
ANALOG  +5V(+/- 0.25V) =  4.90V
ANALOG  -5V(+/- 0.25V) = -4.76V
HVTP    +15V(+/- 1V)   =  14.96V

-----------------------------------------------------------------
-------------------
1980.01.04 10:24:41.122  796 3 OK
head 1 TAXI test OK for 2048 samples

-----------------------------------------------------------------
-------------------
1980.01.04 10:24:41.397  796 4 OK
EM3002
Not applicable for EM3002 HRXB

-----------------------------------------------------------------
-------------------
1980.01.04 10:24:41.422  796 5 OK
EM3002
TEMP = 49 deg

-----------------------------------------------------------------
-------------------
1980.01.04 10:24:41.572  796 6 OK
EM3002
TX TEST = ok

1



-----------------------------------------------------------------
-------------------
1980.01.04 10:25:00.618  796 7 OK
EM3002
HEAD NO.=   796
HRX  NO.= 65022 4EF
HCT  NO.= 61304 4AG
OFFSET 293kHz= -06.7dB
OFFSET 300kHz= -03.4dB
OFFSET 307kHz= -04.4dB

-----------------------------------------------------------------
-------------------
1980.01.04 10:25:00.829  796 8 Error
RX CHANNEL RESPONSE TO COMMON LOW TEST SIGNAL
STAVE     Amp[dB]     Phase[deg]

  0 -0.1 -3.0 
  1 2.4 -2.1 
  2 -1.0 -2.4 
  3 2.5 0.9 
  4 2.3 -0.7 
  5 0.5 -5.9 
  6 2.1 -3.0 
  7 2.3 -3.3 
  8 1.7 -8.2 
  9 -0.3 -9.9 
 10 2.1 -8.0 
 11 2.6 4.0 
 12 0.0 -2.6 
 13 0.3 0.4 
 14 -2.4 -5.6 
 15 -1.0 -2.4 
 16 0.4 4.4 
 17 -1.1 -4.0 
 18 2.5 -3.5 
 19 0.8 -0.2 
 20 -0.8 2.1 
 21 -1.0 -0.2 
 22 -1.4 -3.2 
 23 -1.0 -1.4 
 24 0.0 -4.5 
 25 1.0 4.9 
 26 -11.4* 24.4 
 27 -0.8 -0.6 
 28 2.6 2.8 
 29 2.6 4.0 
 30 2.4 0.6 
 31 -1.0 -1.6 
 32 0.8 -3.4 
 33 -1.2 -6.4 

2



 34 0.1 -7.1 
 35 -0.8 -4.4 
 36 -1.1 -1.1 
 37 2.6 3.4 
 38 0.4 1.4 
 39 2.3 3.0 
 40 -1.5 -2.7 
 41 -0.4 -8.0 
 42 -6.8* 18.8 
 43 -1.4 0.5 
 44 -0.9 -3.9 
 45 0.2 -0.4 
 46 0.1 0.7 
 47 -0.7 1.8 
 48 0.2 0.1 
 49 0.4 0.3 
 50 2.7 6.2 
 51 -0.1 -2.7 
 52 0.4 1.6 
 53 2.7 2.8 
 54 -0.6 0.8 
 55 2.8 6.0 
 56 0.1 -1.1 
 57 2.2 -8.6 
 58 0.6 5.7 
 59 2.8 6.9 
 60 -0.7 1.2 
 61 -11.9* 15.9 
 62 -1.9 -3.7 
 63 0.4 -3.7 
 64 0.6 3.3 
 65 -11.7* 25.5 
 66 -0.1 -4.9 
 67 1.0 -8.1 
 68 0.8 0.2 
 69 2.8 9.2 
 70 2.5 1.1 
 71 -1.0 -0.2 
 72 2.8 2.7 
 73 0.8 1.4 
 74 -9.6* 22.7 
 75 0.9 1.8 
 76 2.8 2.4 
 77 2.7 0.3 
 78 2.5 3.3 
 79 2.8 3.1 

AVERAGE AMPLITUDE  -63.0
VALUES OUT OF RANGE MARKED WITH * 5 AMPLITUDES 0 PHASES
SAMPLE COUNT ERRORS 0
TEST FAILED
RX CHANNEL RESPONSE TO COMMON HIGH TEST SIGNAL

3



STAVE     Amp[dB]     Phase[deg]

  0 -0.6 -2.8 
  1 2.4 -2.4 
  2 -1.7 0.2 
  3 2.5 0.4 
  4 2.1 -0.3 
  5 0.2 -5.1 
  6 2.1 -3.1 
  7 2.0 -2.5 
  8 1.7 -8.6 
  9 -0.6 -10.5 
 10 2.0 -7.3 
 11 2.5 4.1 
 12 -0.3 -2.3 
 13 0.0 -0.6 
 14 -2.9 -5.5 
 15 -1.5 -4.5 
 16 0.1 3.3 
 17 -1.6 -3.7 
 18 2.4 -2.6 
 19 0.5 1.0 
 20 -1.2 0.4 
 21 -1.5 -0.5 
 22 -2.0 -2.4 
 23 -1.4 -0.1 
 24 -0.4 -2.9 
 25 0.6 3.4 
 26 -12.5* 30.5*
 27 -1.5 -2.0 
 28 2.5 3.3 
 29 2.5 4.5 
 30 2.2 0.9 
 31 -1.6 -1.4 
 32 0.6 -3.7 
 33 -1.7 -6.5 
 34 -0.1 -6.2 
 35 -1.3 -2.8 
 36 -1.6 -0.6 
 37 2.5 3.4 
 38 -0.1 2.0 
 39 2.3 2.5 
 40 -1.9 -2.8 
 41 -0.6 -7.7 
 42 -7.6* 22.7 
 43 -2.0 1.1 
 44 -1.4 -4.1 
 45 0.0 0.3 
 46 -0.1 0.3 
 47 -1.3 2.4 
 48 0.1 0.4 
 49 0.1 0.7 

4



 50 2.5 6.4 
 51 -0.4 -3.6 
 52 0.3 1.5 
 53 2.6 1.8 
 54 -1.1 -0.2 
 55 2.7 5.6 
 56 0.0 -1.1 
 57 2.0 -8.5 
 58 0.4 5.6 
 59 2.5 6.9 
 60 -1.2 -1.5 
 61 -13.2* 18.2 
 62 -2.1 -4.3 
 63 0.2 -3.6 
 64 0.4 4.2 
 65 -13.5* 27.3 
 66 -0.4 -3.7 
 67 0.8 -9.0 
 68 0.6 -0.4 
 69 2.5 9.4 
 70 2.6 1.4 
 71 -1.3 -0.9 
 72 2.5 4.0 
 73 0.5 2.2 
 74 -10.3* 26.6 
 75 0.6 2.2 
 76 2.5 2.8 
 77 2.3 0.7 
 78 2.4 3.8 
 79 2.7 3.4 

AVERAGE AMPLITUDE  -22.3
VALUES OUT OF RANGE MARKED WITH * 5 AMPLITUDES 1 PHASES
SAMPLE COUNT ERRORS 0
TEST FAILED

-----------------------------------------------------------------
-------------------
1980.01.04 10:25:10.766  796 9 OK
AMBIENT NOISE LEVELS  in dB relative (uPa^2)/Hz
STAVE     LEVEL

  0 65.3
  1 49.8
  2 62.9
  3 49.7
  4 49.6
  5 60.4
  6 50.4
  7 50.8
  8 49.6

5



  9 61.1
 10 50.4
 11 50.8
 12 60.7
 13 63.5
 14 59.5
 15 52.3
 16 63.6
 17 60.0
 18 51.1
 19 61.1
 20 52.4
 21 66.9
 22 62.0
 23 65.7
 24 63.4
 25 57.7
 26 46.1
 27 49.4
 28 52.2
 29 50.7
 30 50.0
 31 54.9
 32 62.0
 33 52.9
 34 61.5
 35 54.4
 36 65.5
 37 51.8
 38 61.2
 39 50.0
 40 57.3
 41 63.5
 42 54.1
 43 64.8
 44 51.9
 45 61.3
 46 62.6
 47 56.8
 48 61.5
 49 61.9
 50 49.9
 51 56.5
 52 61.3
 53 50.3
 54 53.2
 55 51.7
 56 58.9
 57 50.9
 58 59.5
 59 51.2
 60 64.1

6



 61 45.1
 62 59.9
 63 60.8
 64 61.4
 65 44.8
 66 57.2
 67 63.8
 68 58.5
 69 51.2
 70 50.5
 71 66.0
 72 50.8
 73 65.1
 74 57.7
 75 64.6
 76 49.7
 77 50.1
 78 50.7
 79 51.9

AVERAGE     56.5 
SAMPLE COUNT ERRORS 0
TEST OK

-----------------------------------------------------------------
-------------------
1980.01.04 10:25:17.268  796 10 OK
CPU Test
CPU: SBS Technologies CT7
Clock 851 MHz
CPU temp : 51 C
Board temp : 50 C
IP address : 157.237.2.61

-----------------------------------------------------------------
-------------------
1980.01.04 10:25:17.309  796 12 OK
BSP67 1 TEST: 
Program versions :
BSP67 Master : 2.0.1 101101
BSP67 Slave : 2.0.1 101101
DMA PLD : 0.2 040317
FIFO FPGA : 1.0 040325
MASTER FPGA : 1.0 040329
RXI FPGA : 1.1 060102
cpu to dpram to cpu ok
cpu to dpram to hpi ok
hpi to dpram to cpu ok
master dpram ok
CPU-RXI-Slave OK : 1, 2, 3, 4, 5, 6, 7, 8, Errors: None

7



Master-RXI-Slave   OK : 1, 2, 3, 4, 5, 6, 7, 8, Errors: None
Rawdata FIFO (DMA) OK
Input FIFO (DMA)   OK : 1, 2, 3, 4, 5, 6, 7, 8, Errors: None
Output FIFO (DMA)  OK : 1, 2, 3, 4, 5, 6, 7, 8, Errors: None
DPRAM Synch. (DMA) OK : 1, 2, 3, 4, 5, 6, 7, 8, Errors: None

-----------------------------------------------------------------
-------------------
1980.01.04 10:25:17.811  796 14 OK
EM3002
HCT: 3.0.3 090708
BSP67 Master: 2.0.1 101101
BSP67 Slave: 2.0.1 101101
PU: 2.1.1 120913
Head: 796
DDS:  3.20 2011/12/09
FPGA:1.4 081112

-----------------------------------------------------------------
-------------------
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Appendix 7 – Edgetech/Discovery II Settings 



























Appendix 8 – Hypack & Hysweep Hardware Settings 











Appendix 9 – POS/MV Configuration Settings 



Vessel:

Date: 2/14/2014 Dn: 45

Personnel:

PCS Serial # 5910

IP Address:

POS controller Version (Use Menu Help > About) 7.2

POS Version (Use Menu View > Statistics) MV5 Ver. 7.60
GPS Receivers

Primary Receiver
Secondary Receiver

Location: D M S

Approximate Position: Lat 29 19 59

Lon 94 46 42

DGPS Beacon Station:

Frequency: 301 kHZ

Satellite Constellation (Use View> GPS Data)

Primary GPS (Port Antenna)

HDOP: 0.88

VDOP: 1.13

Sattelites in Use: 10

6,14,15,18,21,22,26,27,29

PDOP 1.597 (Use View> GAMS Solution)

Note: Secondary GPS satellite constellation and number of satellites were exactly the same as the Primary GPS

Angleton, TX (Broadcast ID: 828)

192.168.53.100

SN: 60267823
SN: 67970-00 DC

CALIBRATION AREA
Galveston, TX

POS/MV Calibration Report
Field Unit:

SYSTEM INFORMATION

NOAA S1211

Dan Jacobs, Luke Pavalonis



Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

User Entries, Pre-Calibration Baseline Vector

1.983 Two Antenna Separation (m) 0.009 X Component (m)

0.50 Heading Calibration Threshold 1.98 YComponent (m)

0 Heading Correction -0.001 Z Component (m)

Calibration Procedure:

Start time: 16:27:37 UTC

End time: 16:30:32 UTC

Heading accuracy achieved for calibration: 0.02

Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)

POS/MV Post-Calibration Values Baseline Vector

1.987 Two Antenna Separation (m) -0.007 X Component (m)

0.500 Heading Calibration Threshold 1.987 YComponent (m)

0 Heading Correction -0.006 Z Component (m)

X

X

Save POS Settings on PC (Use File > Store POS Settings on PC)

File Name: 2012_174_S1211_POSMV_Configuration

POS/MV CONFIGURATION

Configuration Notes:  None

POS/MV CALIBRATION

(Refer to POS MV V3 Installation and Operation Guide, 4-25)

GAMS Status Online?

Save Settings?

Calibration Notes:  None





Input/Output Ports  (Use Settings > Input/Output Ports)



Heave Filter  (Use Settings > Heave) Events  (Use Settings > Events)

Time Sync  (Use Settings > Time Sync)

Installation  (Use Settings > Installation)



Tags, Multipath and Auto Start  (Use Settings > Installation > Tags, Multipath and Auto Start)

Sensor Mounting  (Use Settings > Installation > Sensor Mounting)



GPS  Receiver Configuration   (Use Settings> Installation> GPS Receiver Configuration)

User Parameter Accuracy  (Use Settings > Installation > User Accuracy)

Frame Control  (Use Tools > Config)

Primary GPS  Receiver

Secondary GPS Receiver







Appendix 10 – NGS Static-Offset Survey 



US DEPARTMENT OF COMMERCE 
NATIONAL OCEANIC & ATMOSPHERIC 

ADMINISTRATION 
NATIONAL OCEAN SERVICE 

NATIONAL GEODETIC SURVEY 
GEODETIC SERVICES DIVISION 

INSTRUMENTATION & METHODOLOGIES BRANCH 

NOAA SURVEY VESSEL S1211 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

FIELD REPORT 

Kendall L. Fancher 
June 25, 2009 



NOAA SURVEY VESSEL S1211 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

PURPOSE 

The primary purpose of the survey was to precisely determine the spatial relationship 
between various hydrographic surveying sensors, and the components of a POS MV 
navigation system aboard the NOAA survey vessel S1211.   

PROJECT DETAILS 

This survey was conducted in Alpena, MI on the 24th of June, 2009.  The weather was 
warm and clear in the morning, turning hot and clear by mid-day.  For this survey, the 
vessel was on a trailer stabilized by the trailer tongue jack and one hydraulic bottle  jacks.  
The vessel was leveled relative to the IMU. 

INSTRUMENTATION 

A  Leica (Wild) TC300 precision total station was used to make all measurements. 
Technical Data: 

Standard Deviation 
Horizontal angle  0.5 seconds 
Vertical angle 0.5 seconds 
Distance measurement 1mm + 1ppm 

Standard precision prisms were used as sighting targets.  Prisms were configured to have 
a zero mm offset.   

PERSONNEL 

Kendall Fancher NOAA/NOS/NGS/GSD/I&M BRANCH 
(540) 373-1243 
Kendall.fancher@noaa.gov 

Dave Rigney NOAA/NOS/NGS/GSD/STATE ADVISOR BRANCH 
(517) 335-1916 
Dave.Rigney@noaa.gov 



NOAA SURVEY VESSEL S1211 
POS MV COMPONENTS SPATIAL RELATIONSHIP SURVEY 

DEFINITION OF  THE REFERENCE FRAME 

To conduct this survey a right handed 3-D coordinate system was used where the 
Northing (Y) axis runs along the centerline of the boat and is positive from the primary 
reference point towards the bow of the boat.  The Easting (X) axis is perpendicular to the 
centerline of the boat and is positive from the primary reference point towards the right, 
when looking at the boat from the stern.  The Up (Z) axis is positive in an upward 
direction from the primary reference point.   

SURVEY METHODOLOGY 

Three temporary control points, (1, 2, 3), were established around the vessel such that all 
points, to be positioned on the launch, could be observed from at least two separate 
locations.   

Coordinates of 100.000N, 100.000E, and 100.000U were assumed for control point 1.  A 
distance and height difference were measured between control points 1 and 2.  These 
values were used to determine the Northing and Up coordinates for control point 2 of 
121.094N and 99.796U.  An Easting value of 100.000E was assumed for control point 2 
providing for a zero azimuth between the two control points. 

Control point 1 was occupied and control point 2 was observed as a backsight.  After 
initialization, control point 3 and all points to be observed on the launch were measured 
in both direct and reverse. 

Control point 2 was occupied and control point 1 was observed as a backsight.  After 
initialization, control point 3 and all points to be observed on the launch were measured 
in both direct and reverse. 

Control point 3 was occupied and control point 2 was observed as a backsight.  After 
initialization, control point 1 was measured in both direct and reverse.  An inverse was 
computed between the measured and beginning coordinates for control point 1 to assess 
the closure of the traverse.  The traverse closure was 0.6mm horizontally and 0.5mm 
vertically. 

The reference system was rotated using the center of the target atop the IMU housing as 
the point of rotation.  A zero degree azimuth was used during the rotation from IMU to 
Centerline Bow (CLB). The reference system was then translated to relocate the origin of 
the reference frame to the target atop the IMU housing, which was reported to have been 
set on the centerline of the launch. Analysis of points GPSP, GPSS, PBM, and SBM 
indicated that the IMU was not located along the centerline of the vessel and should not 
have been held as a point of rotation for the vessel reference frame. 



Control point 1 was re-occupied and control point 2 was observed as a backsight.  After 
initialization, control point 3, CLS, and the IMU were observed on the launch in both 
direct and reverse.  An azimuth check to control point 3 yielded a closure of 2.8 mm 
horizontally and 0.6mm vertically.  Analysis of the data indicated that the launch had 
moved, relative to the temporary control points, sufficiently to  require that all remaining 
points on the  launch would have to be re-observed. 

Control point 1 was re-occupied and control point 2 was observed as a backsight.  After 
initialization, control point 3, and all remaining points on the launch were observed in 
both direct and reverse. An azimuth check to control point 3 yielded a closure of 2.9mm 
horizontally and 1.0 mm vertically.  

The reference system was rotated using CLS as the point of rotation.  A zero degree 
azimuth was used during the rotation from CLS to CLB. The reference system was then 
translated to relocate the origin of the reference frame to the target atop the IMU housing 
(IMU). 

DISCUSSION 

The positions given for the POS GPS antennas (Zephyr Model 2 p/n 57970-00) are to the 
top center of the antenna. To correct the Z value provided in this report for each antenna 
to the electronic phase center, I recommend the following steps be taken; 

1) Determine the physical height of the GPS antenna.  This information is probably
located on the antenna or with equipment documentation.

2) Investigate to find the electronic phase center offset of the antenna.  This
information is probably located on the antenna or with equipment documentation.
This value may also be available at the NGS website for antenna modeling.

3) Subtract the total height of the antenna from the Z value for each antenna.  This
will give you a Z value for the antenna ARP (antenna reference point)

4) Then add to this value the electronic phase center offset value appropriate for the
antenna model.

The coordinates provided in this report for the single beam are to the center of the bottom 
of the sensor transducer.  No correction has been applied to translate the Z value to the 
electronic phase center. 

The reference point for the side scan sonar (J-arm) was measured with the J-arm 
configured in the deployed position. 



Station Listing 

CLB- CENTERLINE REFERENCE POINT BOW 
A punch mark set in top center of a ballard located near the bow of the 
vessel.   

CLS- CENTERLINE REFERENCE POINT STERN 
A punch mark set in top center of the center keel at a point just aft of the 
generator, located in the generator hold.   

SB- SINGLE BEAM TRANSDUCER REFERENCE POINT 
The center of the bottom of the Single Beam Transducer. 

SSS- SIDE SCAN SONAR REFERENCE POINT 
A punch mark set this survey located at the center of the bottom of the  
J-arm at a point directly below a drill hole which is used to suspend the 
Side Scan Sonar cable tackle.  

IMU- IMU REFERENCE TARGET 
Center of a target affixed to the top of the IMU housing. 

GPSP- POS GPS ANTENNA REFERENCE POINT 
The top center of the port side GPS antenna for the POS system. 

GPSS- POS GPS ANTENNA REFERENCE POINT 
The top center of the starboard side GPS antenna for the POS system. 

PBM A punch mark set in the top center of a ballard located near the stern of the 
launch and along the port side. 

SBM A punch mark set in the top center of a ballard located near the stern of the 
launch and along the starboard side. 



 
Coordinate Listing using the IMU as the Reference System Origin  
 
 
ID  Y(m)  X(m)  Z(m) 
IMU   0.000   0.000  0.000 
CLB   6.540   0.011  1.013 
CLS  -0.913   0.011  -0.333 
PBM  -1.066  -1.129  0.868 
SBM  -1.083  1.135  0.865 
GPSP   3.851  -0.972  2.497 
GPSS   3.873  1.006  2.511 
SB   2.237  -0.178  -0.438 
SSS  -0.683  1.992   2.686 
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